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S ENVI Tutorial: The DEM Extraction Module

Overview of This Tutorial

This tutorial introduces the Digital Elevation Model (DEM) Extraction Module with functionality that enables you to extract
elevation data from stereo imagery to create a DEM. A DEM is a raster grid of elevation values that represent a surface.
DEMs are useful for many applications such as mapping, orthorectification, and land classification. They are often used to
create contour maps and perspective maps and for various types of land use planning applications.

The DEM Extraction Module allows you to extract DEMs from pushbroom stereo images, such as those coming from the
ASTER, IKONOS, OrbView3, QUICKBIRD, and SPOT satellites. It is important that the imagery have associated rational
polynomial coefficients (RPCs) which contain necessary information about the sensor model. In addition, RPCs are used
in tie point generation and to calculate the stereo image pair relationship.

The DEM extraction process requires a stereo pair of images containing RPC positioning from either an along track or an
across track satellite acquisition. Along track stereo images are acquired on the same orbital pass by a satellite which
usually has more than one sensor looking at the Earth from different angles. Across track stereo images are those taken
by the same sensor on multiple orbits.

The DEM Extraction Module is comprised of the DEM Extraction Wizard and three DEM tools: the DEM Editing Tool, Stereo
Pair 3D Measurement Tool, and the Epipolar 3D Cursor Tool.

Note
The DEM Extraction Module requires an additional license in your installation; contact your ENVI sales
representative to obtain a license. If you are not licensed for the DEM Extraction Module, the tool will
be disabled.

In order to run this tutorial, you must have ENVI installed on your computer.

Files Used in This Tutorial

CD-ROM: Tutorial Data CD #3
Path: envidata/ASTER/

U. S. Geological Survey Data. This ASTER Level 1 data are processed by the Japanese Ground Data System (GDS) and
archived by the Land Processes Distributed Active Archive Center (LP DAAC) at the USGS EROS Data Center (EDC). The
data contains advanced spaceborne thermal emission and reflection radiometer (ASTER) data files in the hierarchical data
format for earth observing system (HDF-EOS).

File Description
AST_L1A.hdf ASTER Level 1 data
AST L1A.hdf.met Metadata for above

Working with the DEM Extraction Wizard Input Stereol mage par
DEM extraction is a multi-step decision making process involving the setting of Define GCPs
many parameters used in different steps. These steps can be run individually, or

from within the DEM Extraction Wizard. The Wizard guides you through nine |
steps, presenting you with objective parameters, such as minimum/maximum Define Tie Points
elevation of the area of interest, as well as other strategy parameters that |

depend upon the terrain relief, cultural content, image quality, shadowing, and
the desired speed of operation.

Specify parameters

Right is a diagram of the DEM Extraction Wizard workflow. Output DEM and
examine results

|
Edit DEM
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The Wizard allows you to step forward, backwards, and to save the workflow at
any step so that you can continue at a later time.

Inputting a Stereo Image Pair

The DEM extraction process begins with input of a stereo image pair that contains or has associated RPCs. For this
demonstration, we will extract a DEM from an ASTER L1A product using the DEM Extraction Wizard. ASTER uses the
visible near infra-red (VNIR) telescope’s normal (3N) and backward (3B) viewing bands for along-track stereoscopic
observation. In this example, we will use the 3B band for the left image and the 3N band for the right image.

Select a stereo pair of images containing RPC positioning from either an along track or an across track satellite
acquisition.
1. Before attempting to start the program, ensure that ENVI is properly installed as described in the Installation
Guide that shipped with your software, then start ENVI.

2. From the ENVI main menu bar, select File > Open _ ) ) =
External File > EOS > ASTER. 4l DEM Extraction Wizard: Step 10f 9 (2 |[B]X]

3. Navigate to the envidata\ASTER directory, select — Steren Image Pair
the file AST_L1A.hdf from the list, and click Open.
The Available Bands List is displayed.

4. From the ENVI main menu bar, select Left Image
Topographic - DEM Extraction 2> |ﬁSTEF| WMIR Band3M:AST_L1A hdf
DEM Extraction Wizard = New.

5. Click the Select Stereo Images button. The Select
Left Stereo Pair Image dialog appears. The order of
the data entry here should not matter. However, in
tools such as the tie point generation, you will likely
see different tie point selections and calculated errors Finirmum Elevation [1455.04
because the solution will be different.

Select Stereo Images. ..

Right Image
|.f-‘-.5 TER WMIR Band3B:AST_L1A hdf

— Scene Elevation in Meters

6. Select the ASTER VNIR Band3N option and click M aximum Elevation|4245.00
OK. The Select Right Stereo Pair Image dialog
appears.
7. Select the ASTER VNIR Band3B option and click Cancel ||| Hep ||| Save.. | | Newt - |

OK. The scene minimum and maximum elevations
are estimated for you using the associated RPC
information and a World DEM file included in the ENVI sample datasets.

8. Click Next to continue.

Defining Ground Control Points (GCPs)

In the second step of the Wizard, you will be provided with the option to define or use existing GCPs. When defining
GCPs, you can choose any of the following options:

&l DEM Extraction Wizard: Step 2 of 9 |: E|g|

e No GCPs. Choosing this option would result in a
relative DEM. A relative DEM is a DEM with possible

— Source of Stereo GCPz

differences in position, scale and rotation from _
geodetic coordinates on the ground and mean sea " Mo GCPs [ielative DEM values anly]
level. " Define GCPs Interactively
o Define GCPs Interactively. Choosing this option ™ Read GCPs From File
would require that you manually enter, load, and edit

GCPs that will tie the DEM to a planar map
projection. The result of which would be an absolute I_ ﬂ
DEM. An absolute DEM uses ground control and has

horizontal and vertical references systems tied to
these geodetic coordinates. Cancel | Help | Save.

- Pres | MHest - |
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Read GCPs From File. Choosing this option would require that you select a GCP file from which to read GCPs.

For this exercise, you will not use GCPs so the resulting DEM values will be relative elevations.

1.

Click the No GCPs radio button. Note that the Examine and Edit Stereo GCPs option (step 3 of 9) is not
available. It is only available if you have loaded a GCP file into the Wizard. Clicking Next will skip step 3 and
move you on to step 4 of the DEM Extraction Wizard.

Click Next to continue.

Defining Tie Points

Next, the relationship between the stereo images must be defined by selecting or generating tie points. The tie points
are used to define the epipolar geometry and create epipolar images, which are used to extract the DEM. When defining
tie points, you can choose any of the following options:

Generate Tie Points Automatically. ENVI can generate tie points automatically, based on terrain features
within the image.

Define Tie Points Interactively. Choosing this option would require that you manually define tie points
between the two stereo images.

Read Tie Points From File. Choosing this option would require that you select a tie point file from which to
read the tie points.

For this exercise, you will generate tie points automatically.

1.

Click the Generate Tie Points Automatically radio
button.

A1 DEM Extraction Wizard: Step 4 of 9 g@@

Automatic tie point generation requires four parameters — Source of Tie Points

to be specified: * Generate Tie Poinks Automabicall

e The Number of Tie Points you wish to

t " Define Tie Points |nteractively
generate.

. . . " Read Tie Paints Fram File
e The Search Window Size and the Moving

Window Size. The Search Window is a
defined subset of the image. The Moving

— Automatic Tie Points Generation —

Window defines an area within the Search Mumber of Tie Points |25 &

Window that is used to scan and find a _ _ —

topographic feature match for a tie point Search Window Size [101 <
lacement. The size of these windows should

b M ovirg Window Size |13 -

be considered with respect to the spatial

resolution of the data. For example, higher . .
. . ’ R Elevat 28580.02

spatial resolution data, such as sub-meter saian Eevaian

QuickBird imagery, should use larger window

sizes in order to increase the reliability of E=amine and Edit Tie Points |Tes ﬂ
finding similar features between the stereo

image Moving Windows.

<-- Prey | M et - |

Eanu:el| Help| Save. .

e The Region Elevation is the average
elevation of the region based on the dominant
elevation of the image. It is estimated based on the associated RPC information.

Note
Increasing the number of tie points, the Search Window size, and/or the Moving Window size will
increase the processing time but should also increase the reliability of the matching.

3
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2. Increase the number in the Search Window Size field to 101 (type and replace the current number in the field
or use the increase/decrease buttons). Note that the Search Window Size is always an odd number in square
pixels and must be larger than the Moving Window Size.

3. Increase the number in the Moving Window Size field to 19, which is reasonable for 15 m ASTER data.

4. Ensure that the Examine and Edit Tie Points toggle is set to Yes so that you can review the tie points and edit
those which are less than optimal, then click Next to continue. It may take a few minutes to generate the tie

oints. —
P &l Automatic Tie Points Generation g@g|

Band 1:ASTER VMIR Band3M:AST_L14 hdf
Band 2ZASTER YMIR Band3B:A5T_L14 hdf

Cancel

Editing Tie Points

Once the tie points have been generated, step 5 of 9 of the DEM Extraction Wizard (View and Edit Tie Points) will display
both images and tie points for examination. Explore and experiment with the options in this step, you can use the Reset
button to undo the last change.

1. Try manually entering x and y locations for the left and right images.

2. Move the Zoom box to a new location in one of the ) DEM Extraction Wizard: Step 5 of 9 E@E|
images and click Update to update the tie point. '

. . ] — Left/Right Stereo Image Coordinate
3. Use the Current Tie Point arrow buttons to examine

each point. Left 3| 435.00 Right »|1018.31

4. Click the Likely Error Rankings drop-down button. li . li
This lists the ti)e/ points in ordergof relariive likelihood of Left|447.00 Right 1023 32
error. The first tie point listed is considered the “most
likely” to have error. However, it is possible that the top — iew and Edit Tie Points
ranking tie point has very little error since it is only an Current Tie Paint: 1 of 25 ﬂﬂ
approximation. In this case, you should check through
the list for pixels with obvious misalignment but with Goto | Add | Update | | Delete | Delete Al |
lower error.

. ) ] Show Table. .. | Save... | Restare... |

5. Use the Auto Predict section to help estimate
placement of the tie point in the image. Likely Errar Rankings v|

6. Examine the Maximum Y Parallax value displayed on W amirrim ¢ Parallas: 06525
the Wizard screen to see if you have improved the
amount of error in the tie points. Any time you update — Auto Predict

a tie point, you should examine the Y Parallax value. It
provides an estimate, in pixels, of displacement
between the images in the y direction. Tie points Region ElevatiDnIW
should be adjusted so that the Y Parallax is minimized.
Ideally, it would display 0, indicating no offset in the y
direction - all points are displaced in the x direction
only. The maximum allowable Y Parallax value is 10 Lancel | Help | SAVE...
pixels. You must reduce the value to less than 10 in
order to continue DEM extraction.

Predict Left | Predict Right | Params... |

<-- Prew | M ert - |

7. Once you have a Y Parallax under 10 pixels, click Next to continue.

4
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Calculating Epipolar Geometry and Images

Using the tie points, ENVI will calculate the epipolar geometry and epipolar images that are used to extract the DEM.
These epipolar images describe the relationship between the pixels in the stereo pair and they can be viewed in 3D using
anaglyph glasses. However, it should be noted that approximately 10% of the population cannot see in stereo, so the
images may not appear in 3D for these individuals.

1. The epipolar parameters dialog allows you to enter the

name for the left and right epipolar images and select 1 DEM Extraction Wizard: Step 6 of 9 E@@
how and where you wish to output the images.

— Left Epipolar |
2. You also have the option in this dialog to apply an = ERipearimage

Epipolar Reduction Factor, which will reduce the Output Besultto & File  © Memary
resolution of the extracted DEM. This is useful if you do
not require a full resolution DEM for your application or .

L . ’ Dutput | Fil Ch
demo as it will take less processing time to create the B
DEM. For example, this ASTER stereo pair has a CHRSIMASTERMWAST_L1A_left_epipolar

resolution of 15m. If the requirement was for a 30m
DEM, you could reduce the DEM by 2 using the
Epipolar Reduction Factor.

— Right Epipalar Image

3. Using the Examine Epipolar Results option, you can Output Resultts & File & Memory
view the epipolar images prior to the DEM extraction.
The images can be viewed in 3D using the anaglyph Output Image Filename  Choose

glasses provided in your software package. CARSIASTERWAST L1A. right_spipolar

You can view the images using two different RGB

triplets. The first option allows you to view the left — Epipolar Parameter

epipolar image as red and the right epipolar image as E pipolar Fleduction Facm,m
green and blue. The second option allows you to view

the right epipolar image as red and the left epipolar — Examing Epipolar Results

image as green and blue. _ -
RGB-Left Right Right... |

Click RGB=Left,Right,Right. The resulting epipolar
image is displayed as an RGB triplet. If viewed through
the anaglyph glasses, the image will appear in 3D.

RGE=Right Left Left. . |

Depending on which image was initially entered as the Cancel | Help | Save.. <= Prey | Hext - |

right or left stereo image, the RGB triplets can be
viewed as an inverse where peaks appear as valleys

4. Click Next to continue.

5
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Specifying Parameters

Now that you have created the epipolar images, you will need to specify the DEM output projection and extraction
parameters.

1 DEM Exiraction Wizard: Step 7 of 9 (2 |[B](X]

Specifying DEM Output Projection Parameters

Step 7 of the DEM Extraction Wizard allows you to set
parameters for the DEM output projection and map extents. You
have the option to change things such as the output projection

type, pixel size, or output image size. Experiment with some of ﬂ
the following options.

e You can change the Eastings and Northings fields |4EIEE1 48170  E  Change Proj... |

(E and N respectively) to Latitude and Longitude

— Output Projection and Map Extent
|Ipper Left Corner Coordinate

Proj: UTH, Zone 13 Harth
Dratunn: wiE5-84

(Lat and Lon) by clicking the toggle button ¥t next to 42751147983 N |Units: Meters
the map projection field.
e Click the Change Proj button to change the projection ¥ Pivel 5ize|15.00000000  Meters

or projection units.
. . . . ¥ Piwel S5ize|15.00000000  Meters
e You can type in values for X Pixel Size and Y Pixel

Size in the fields provided. Output % Size[5130 2 piels
e The Output X Size and Output Y Size values describe

the output DEM size in pixels. This is the overlapping Output 5i23|49':'8 = Dingls
region of your output projection.
g y put pro] Optiong «

e The Options drop-down button allows you to set the
output size units, choose options when pixel sizes
change, restore initial values on this step of the Wizard,
and use the map extent from an existing file.

Cancel | Help | Save.. <-- Prew | M et - |

For this exercise, you will use the defaults provided for this
screen. 41 DEM Extraction Wizard: Step B of 9 [ |[B][X]
1. Examine the options provided.

— DEM Extraction Parameters

2. Click Next to continue. Mirimum Canelation lm
Specifying DEM Extraction Parameters Background Yalue [-999.00
Step 8 of the DEM Extraction Wizard allows you to specify the
parameters for the DEM extraction. Here you can define Edge Trimrming noog =

thresholds, set the size of the area in which you wish to perform
image matching, determine the level of terrain detail, and specify Moving Window Size |5 %G v|
where to save your DEM result.

e The Minimum Correlation value is the correlation Terain Detai |'—E“’E' 3 :"
coefficient threshold used to determine whether or not
the points within the Moving Windows are a good match. — DEM Result
If a correlation coefficient is smaller than this minimum,
Cutput Data Type |Integer -

then the points are not considered to be a good match.
In general, correlation values between 0.65 and 0.85 are

reasonable, but for larger Moving Window sizes, a less Output Resultto & File 7 Memary
strict correlation can be used.
e Edge Trimming indicates the normalized percentage of Output DEM Filename  Choose |
trimming to be applied to the outer edges of the output |E:'\H5I"-.test
DEM.
e The Moving Window Size defines the area in which to
compute the correlation coefficients between the two Cancel | Halp | Save | < Pray | Nt - |
6
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images. As with automatic tie point generation, a larger window size should be used with higher resolution
imagery in order to increase the reliability of finding similar features within the Moving Window.

DEM extraction uses image matching to find matching features on the left and right image of the stereo pair. The
use of Terrain Detail determines how precisely you wish to represent the terrain in the DEM output. This option
controls the number of image pyramid levels used during image matching. The levels range between Level 1
(minimum) and A (maximum), where Nis determined by the epipolar image resolution. Level 1 terrain detail
indicates that image matching stops after the coarsest level of image matching is finished. Level V indicates that
image matching is performed on the highest image resolution possible (the epipolar image resolution). Higher
levels of terrain detail will require a more rigorous level of image matching and will affect the processing time
required to extract the DEM.

You can set parameters for the DEM result. These parameters include the Output Data Type field, which allows
you to choose between Integer (default) or Floating Point. You can also choose to save the output to File
(default) or Memory, and you can select where you wish to save the DEM result.

For this exercise, you will use the defaults provided for this screen to produce a moderately detailed DEM.

1.
2.
3.

Examine the options provided.
Type or choose a filename in Output DEM Filename field.

Click Next to start the DEM extraction process. The processing time required can be significant, depending on
your choices for Moving Window Size and Terrain Detail. As the processing completes, the various files created
(Left Epipolar Image, Right Epipolar Image, and Elevation result) appear in the Available Bands List.

Examining Results

Once your DEM extraction is complete, you can examine and/or edit the resulting DEM. The last screen of the Wizard
provides two options, both options will load the DEM result to display but one will also open the DEM Editing Tool which
will allow you to edit the DEM. You will explore each of the options in this step to examine and edit the resulting DEM.

Loading DEM Result to Display and Performing 3D SurfaceView
To begin with, you will load the DEM result to display and perform a 3D surface view using the spectral bands from the
original ASTER image to examine the DEM results.

1.

Click the Load DEM Results to Display button (do not close the DEM Extraction Wizard). Since this extracted
DEM has been projected using the UTM coordinate system, you will need to use a projected image to perform the
overlay in order to have properly aligned image and DEM pixels.

From the ENVI main menu bar, select Basic Tools & Preprocessing 2 Data-Specific Utilities > ASTER 2>
Georeference Data. This option will georeference the VNIR bands of the ASTER 1A data.

Select the AST_L1A.hdf file and click OK (see image below).
i#l| Input ASTER Image 3

Select Input File: File Infarmation:
test . . File: C:\D'ocuments and Settings‘mwelchiby Docun
AST_L1A_right_epipolar Diirng: 4100 % 4200 » 3 [B50]
AST_L14 left_epipolar Size: [Byte] 51,660,000 bytes.
File Type : HDF EOS ASTER
AST_L1A hdf Senszor Type: ASTER
AST_L1A hdf Biwte Order : Host [Intel)
AST_L1A hdf Projection : *RPC* Geographic Lat/Lon

Pixel : 0.000219 » 0.000154 Degrees
Datum  WES-84
Wavelength : 0,556 to 0.807
Upper Left Carner: 1.1
Description: ASTER level 14 data
Imported into EMYI [wed Jun 29

09:01:10 2008]
‘ Cpatial Subset |Fu|| Scene |
‘ Spectral Subset |3x'3 Bands ‘
‘ aK | Cancel | |H Dpenvl

7
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4. Select UTM and click OK.
5. In the Output Result to area, select File, type or choose a file name and location, and click OK.
6

Now you will load a color infrared (CIR) image. From the Available Bands List, right-click the file you just created
and select Load CIR to <current>. Move the Image box in the Scroll window to an area in the image.

~

From the Display group menu bar, select Tools - 3D SurfaceView.

8. Select the newly created DEM Elevation input band and click OK.

9. Accept the default parameters to display the surface by clicking OK.

10. Look for unusual artifacts. Use the Options menu in the 3D SurfaceView window to set options for viewing the
image. If you find areas that you wish to alter, you can use the DEM Editing Tool.

#1 3D SurfaceView (Vert Exag: 5.0)
File Options Help

Loading DEM Result to Display with Editing Tool
The DEM Editing Tool, which is a component of the DEM Extraction Module, allows you to interactively edit pixel values
within a region of interest (ROI) using one of seven different methods.

1. From the DEM Extraction Wizard dialog, click the Load DEM Result to Display with Editing Tool to open the
DEM in a display group with the DEM Editing Tool available.

2. Move the Image box in the Scroll window to an area in the image.

3. Draw a polygon ROI by clicking the left mouse button in the Image window to establish the first point of the ROI
polygon then selecting further border points in sequence by clicking the left button again. Close the polygon by
clicking the right mouse button.

8
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4. Using the DEM Editing Tool, the new ROI, or the entire DEM, TR Editdg T EE}E'

can be replaced with a single value, a smoothing filter, with Region Of Interest Definition
the_mean_of the area, and so on. Explore the options Window: & Image © Scroll € Zoom € OFf
available in the Method drop-down list in the DEM Editing

Tool dialog.
° Type |Polygon EDIDr.

If you are satisfied with your edits, you can save the file with
the new values. If you do not like the effect, you can choose — Edit Pixel ¥ alues ————————— Unda

to undo your edits to the DEM. Y ———— e

Y ethod |Heplace vaith value - Edits: 0
The DEM Editing Tool can also be used on spectral data to 4‘
edit pixels in a single band. Yalue

5. For this exercise, you do not have to save your edits. Click Apply to Region of Interest |
Cancel. |

6. Click Finish then click No to close the DEM Extraction Wizard
without saving your place in the Wizard. |

Cancel

Working with the Stereo 3D Measurement Tool

The Stereo 3D Measurement Tool is another tool available with the DEM Extraction Module. This tool allows you to
interactively calculate elevations from stereo images and associated RPC information given a single tie point.

1. From the ENVI main menu bar, select Topographic 2 DEM # Stereo Pair 3D Measure... E@E|
Extraction = Stereo 3D Measurement.

2. Select the ASTER VNIR Band3N option and click OK.
Select the ASTER VNIR Band3B option and click OK.

— Left/Right Stereo Image Coordinate

Left = |201.00 Right | 78277

4. In either the left or right Image window, move the Zoom box over Left ¥|200.00 Right v|743.43
a feature whose 3D measurement you wish to collect. Using the
buttons on the Stereo 3D Measurement Tool dialog, click Predict — Map Location and Elervation
Right or Predict Left to have the Zoom box in the second image S ey

H H o) - leograpnic LatsLon

center on the conjugate point. ﬂ Datlum: W%‘SI-:IE4

5. Click Get Map Location to compute the Lat/Lon and elevation
based on the RPS and selected points. The regional elevation is Lat|38 |35 |15_m
estimated from the RPC information, but if you have a more
accurate elevation for the region, then you can enter this value L.:,n|.1 05 |52 |3?_44 E
here.

6. You could choose to collect and save these points as an ENVI Elevation|2855.1438 Meters

vector file or as a 3D shapefile using the Export Location button.
Get Map Location | Ewport Location |

7. Click Cancel to close the Stereo 3D Measurement Tool.

— Auto Predict
Predict Left | Predict Right | Params... |

Reqion Elevation | 2850.02
Cancel

9
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Working with the Epipolar 3D Cursor Tool

The Epipolar 3D Cursor Tool is another tool available with the DEM Extraction Module. This tool allows you to perform 3D
measurements in a 3D stereo viewing environment based on an existing epipolar stereo pair of images. You can view an
anaglyph of epipolar stereo imagery and adjust the height of the cursor to extract elevation data. As you view the
surface, you can collect points then export them as points, lines, or polygons to an ASCII file, EVF file, or ArcView 3D
Shapefile.

1. From the ENVI main menu bar, select Topographic - DEM Extraction - Epipolar 3D Cursor.

2. Select the Left Epipolar Image option and click OK. #1 #1 Epipolar 3D Cursor g@@

3. Select the Right Epipolar Image option and click OK. The — Display Windaw
epipolar stereo image opens in a new display group, with left o O Gl O 7 i
epipolar image as the red band, and the right epipolar image as e e eem
the blue band.

— 30 Cursor Parameters
4. The cursor in the Image window is now a double red and blue _ = =
cursor which, when viewed using the anaglyph red/blue stereo e’ EEEEE S
glasses, merges together into a single cursor. You can control the

; o Snhap to Ground Parameters. .. |
3D cursor using specific mouse and keyboard controls. P

e Use the mouse to move the 3D cursor around the epipolar Swap Left/Right in Dizplay |
stereo image.
e Click the left mouse button to snap the 3D cursor to the — Map Location and Elevation
gr.ound. ] t Froj : Geographic Lat/Lon
e Click the middle mouse button to export the map and M b atum: wisee
elevation for the point to an ENVI Point Collection table.
e Use the right and left arrow keys on the keyboard to move Lat|38 |E |54_|:|E
the 3D cursor one pixel to the right or left. DDEG
Lon|-108 |1 |59.85

e Use the up or down arrow keys on the keyboard to move
the 3D cursor one pixel toward the top or bottom of the

image. Elewation | 2855.7851 Meters

e Use the + or - key on the keyboard number pad to raise or
lower the apparent elevation of the 3D cursor.
Cancel

5. Once you have explored some of the options available in the
Epipolar 3D Cursor Tool, click Cancel to close the tool.

10
ENVI Tutorial: The DEM Extraction Module



	Overview of This Tutorial
	Files Used in This Tutorial

	Working with the DEM Extraction Wizard
	Inputting a Stereo Image Pair
	Defining Ground Control Points (GCPs)
	Defining Tie Points
	Editing Tie Points
	 Calculating Epipolar Geometry and Images

	 Specifying Parameters
	Specifying DEM Output Projection Parameters
	Specifying DEM Extraction Parameters

	Examining Results
	Loading DEM Result to Display and Performing 3D SurfaceView
	Loading DEM Result to Display with Editing Tool


	Working with the Stereo 3D Measurement Tool
	 Working with the Epipolar 3D Cursor Tool

